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11  BBeeffoorree  yyoouu  ssttaarrtt  

11..11  UUssiinngg  TThhiiss  MMaannuuaall  

The documentation of proVISION and its components is divided into the following parts: 

System Overview 

This section contains general information about the System requirements and the installation of 
the software. 

The proVISION GUI 

This section describes the components of proVISION graphical User Interface: the menu items 
and their functionality, the toolbar buttons and the child windows. 

Image Acquisition 

This section describes the acquisition process and the directory structure of the proVISION 
database. The dialog boxes used for the control of the parameters during the acquisition are 
described too. 

PIV Processing Tools 

This section provides information about the processing of acquired images and the processing 
in batch mode. It also provides a description of the calibration procedures and the image 
masking. 

How To… 

This section provides detailed step-by-step instructions on the following tasks: 

• Edit the general options parameters 

• Acquire data 

• Save image data 

• Calibrate images 

• On-line processing 

• Process file images 

• Configure the results 

• Configure Tecplot 

PIV Processing Examples (Tutorial) 

This section contains examples of application of PIV (2D and 3D). 

Appendix 

This section contains some additional information about third-party software and graphic 
formats. 
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22  SSyysstteemm  OOvveerrvviieeww  

22..11  OOvveerrvviieeww  

The proVISION™ software package is used to operate the IDT-1000 system and the IDT-
2000 control modules with the cameras for the image acquisition. The software package 
includes the PIV processing functionality. The user has the choice of installing and configures 
the software package to operate a PC as a stand-alone unit for the processing of file images 
and presentation of results.  

The minimum hardware configuration of the PIV system, for use in 2D PIV applications, 
includes:  

• The computer system with the timing control card and standard IEEE-1394-1995 (OCHI 
compatible) port(s). 

• Timing Control Module. 
• Timing Interconnect Cable (SB68). 
• sharpVISION™ model 1300DE Camera with lens (50 mm Nikon-standard). 
• Cables (IEEE-1394 and trigger for the camera). 

The Timing Control Module manages and distributes the entire trigger timing signals to the 
illumination laser and cameras. There is a trigger input signal for synchronization with external 
events as well as the following output signals: 

• Laser: Flash Lamp A, Flash Lamp B, Q-Switch A and Q-Switch B triggers. 
• Camera: Camera(s) trigger. 
• Trigger OUT (bypass of trigger IN signal). 

Optionally the user may configure the system for use with Roper (Kodak) ES1.0 and ES4.0 
cameras. In this case a frame grabber board is also installed in the computer. These cameras 
are controlled by and transmit the data via a high-density (DB68 to DB100) cable (25’-150’ in 
length). 

The system can be configured for use in 3D PIV applications as well. In this mode of operation 
the system includes additionally: 

• Second sharpVISION™ model 1300DE Camera with lens (50 mm Nikon-standard). 
• Additional Cables. 
• Scheimpflug Mounts. 

The 3D PIV system may be configured with a motorized system for the Scheimpflug focusing 
mounts. This option includes: 

• Motorized mounts and Cables with DB25 connectors (one per camera). 
• Motor Control Unit and a serial DB 9 Cable. 
• The host PC via the serial communication port and the serial cable operates the Motor 

Control Unit. 
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A third optional configuration includes a PCI bus expansion unit that can accommodate all the 
boards, IEEE-1394, timing controller and frame grabber(s) external to the PC. This expansion 
unit communicates with the host PC by means of a single high speed PCI link. 

NOTE: The previous hardware revision IDT model 1000 used the expansion unit as a standard. All 
the hardware including frame grabbers, timing control unit and motor control unit were housed 
together with the PCI expansion. 

 

 

 

22..22  SSyysstteemm  rreeqquuiirreemmeennttss  

The minimum system requirements to work with the proVISION software are: 

• PENTIUM™ processor or above. 

• Windows NT™ 4.0 or Windows 2000™ Professional Operating System. 

• 256 MB RAM. 

• 500 MB free Hard Disk space for full installation. 
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22..33  SSooffttwwaarree  IInnssttaallllaattiioonn  

VERY IMPORTANT: IN SYSTEMS THAT ARE DELIVERED WITHOUT THE HOST PC BEFORE 
ANY HARDWARE IS INSTALLED THE SOFTWARE NEEDS TO BE COMPLETELY INSTALLED 
TO INSURE THAT THE DEVICE DRIVERS THAT RUN THE SYSTEM CAN DETECT THE 
INSTALLED HARDWARE AND WORK PROPERLY. 

The complete software installation comprises three (sharpVISION cameras) or four (Kodak 
Cameras) CD's. These CD's contain the required drivers and other software components as 
well as example images. Two of the CD's install device drivers and contain third party software 
from National Instruments and are labeled NI-DAQ and NI-IMAQ (Kodak cameras only). The 
third CD installs the Tecplot data presentation package from AMTEC Engineering. The fourth 
CD contains the IDT proVISION software and device drivers and the example images. The 
installation self-running script prompts the user for additional information, such as the 
directories for the files. The following approach is recommended: 

1. Install the software on the CD labeled NI-DAQ. The software should be installed in 
[drive letter]:\Program Files\National Instruments\NI-DAQ. If the system is being 
configured to use sharpVISION cameras skip step 2. 

2. Install the software on the NI-IMAQ CD (Kodak cameras only). The software should be 
installed in [drive letter]:\Program Files\National Instruments\NI-IMAQ. When 
prompted there is no need to install any documentation. 

3. Install Tecplot: the proVISION software package uses Tecplot as the primary data 
visualization tool. If the Tecplot software package has not been previously installed, install 
it on [drive letter]:\Program Files\Tec80. 

4. Install the proVISION CD. Follow the instructions, and enter the appropriate camera 
model and number, as well as the motor type when applicable.  If the hardware includes 
the motorized option, enter the appropriate motor type when prompted. The recommended 
installation directory for the proVISION package is [drive letter]:\Program 
Files\IDT\proVISION. Upon completion a child directory labeled Db (database) is created. 
It is under this directory that the image, system configuration and processed files are 
stored. The structure of these files is further explained in the following chapters (Image 
Acquisition and Processing) 

CONFIGURING THE SOFTWARE WITH THE WRONG MOTOR TYPE MAY RESULT IN 
DAMAGE TO THE MOTOR AND/OR CAMERAS. 

Remember to follow the instructions that are prompted by each installation script. Reboot 
the system as required. 

If frame grabbers are installed with the system remember to configure the memory buffers to 
accommodate acquisition of image sequences. A complete description of how to configure 
the buffers is given in the Appendix. 
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33  TThhee  pprrooVVIISSIIOONN  GGUUII  

33..11  OOvveerrvviieeww  

The software package is designed as a general purpose image acquisition and processing 
package to which a variety of “software tools” may be incorporated. The graphical user’s 
interface (GUI) is based on the standard Microsoft Windows applications interface. Upon 
installation the program is executed by activating the icon on the desktop. The Figure below 
shows the GUI, and the initial menu structure available to the user. 

The toolbar and menu structure of the proVISION interface is described in the following topics. 
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33..22  MMaaiinn  pprrooVVIISSIIOONN  TToooollbbaarr  

The Main Buttons Bar is displayed across the top of the main window under the Menu Bar. The 
table below shows all the objects available on the Main Buttons Bar, with a short description: 

 New File 
Press this button to create a new image. A dialog box appears allowing you to choose the 
image size and the background color. 

 Open File 
Press this button to open an Image File. All common color and monochrome image file formats 
are supported, to include: TIFF, PCX, BMP and GIF. 

 Save File 
Images may be manipulated by a variety of operators: Morphological, LUT, etc. Upon 
modification images may be re-saved. This is done by the Save command. The file name as 
well as the file type for storage is selected by the user’s choices. Uncompressed and 
compressed file formats are supported. Press this button to save.  

 Copy 
Press this button to copy in the clipboard the current image or a selection. 

 Paste 
Press this button to copy in the current image the content of the clipboard. 

 Print 
This button opens the Print common dialog box. The user can select the printer from a list and 
other print settings, and then print the current image. 

 New PIV Batch 
This button opens a new PIV processing window, used to obtain the velocity information from 
archive image data. See the topic "PIV Processing Window" for a detailed description. 

 New PIV Analysis Window 
This button opens a new PIV processing window, used to obtain the velocity information from 
archive image data. See the topic "PIV Processing Window" for a detailed description. 

 Open PIV Live Video Windows - Cameras 
This button opens a new Live Video Session, the image acquisition tool with an embedded PIV 
processing tool. See the topic "Image Acquisition" for a detailed description. 
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 Open Laser/Camera Trigger Control Window 
This button opens the Laser/Camera Trigger Control dialog box used to synchronize and 
operate the laser illumination source. See the topic "Laser/Camera Trigger Control" topic, for a 
detailed description. 

 Open Options Window 
The general options, configured during the installation can be updated to reflect changes on 
the hardware configuration and/or the path of the database used to store images and data files. 
See the topic "Edit the general options Parameters" in the "How To…" section for a detailed 
description. 

 Open Current Session Settings Window 
When a PIV processing window or the image Acquisition window is open, provision sets a path 
in the database where the images and/or the data processing will be stored. The button 
enables a dialog box that shows the current settings of this path. 

 Help Contents 
This button displays the on-line Help documentation (this document). 

3.2.1  
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33..33  CCaammeerraa  TToooollbbaarr  

The Camera Buttons Bar is displayed across the main window under the Main Buttons Bar and 
is visible only when the camera windows are open. The table below shows all the objects 
available on the Camera Buttons Bar, with a short description. 

The operational buttons are presented in the manner that is usual with digital cameras. They 
include the play, record, stop and rewind controls. 

 Record 
This button enables the image acquisition. To record images into memory the user needs to 
press the record button prior to the play button. 

 Stop 
This is the only button with added functionality as compared to standard camera interfaces. 
When pressed the button performs the acquisition of an image (if the camera is in continuous 
or triggered mode) or an image pair (if the camera is in double exposure mode) to memory. If 
you press the Stop button when the Play button is pressed, the cameras stop playing.  

 Play 
This is the standard Play button of any camera interface. Its functionality changes if the Record 
button is pressed or depressed. If the button is pressed, it starts the image memory acquisition. 
If it's depressed, it starts the camera play. 

 Previous Frame 
When a sequence of image frames is recorded in memory, all the frames can be displayed. 
Press this button to move to the previous frame. When the current frame is the first of a 
sequence, this button is grayed. 

 Next Frame 
When a sequence of image frames is recorded in memory, all the frames can be displayed. 
Press this button to move to the next frame. When the current frame is the last of a sequence, 
this button is grayed. 

 Rewind 
This button animates the recorded sequence in reverse order. The frames are displayed in 
sequence, from the current frame to the first. 

 Fast Forward 
This button animates the recorded sequence. The frames are displayed in sequence, from the 
current frame to the last. 

The setup buttons controls the camera settings: 
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 Record Setup Window 
This button opens the Record Control dialog box. See the topic "The Record Dialog" for a 
detailed description. 

 Camera Settings Window 
This button opens the camera setup dialog box. This dialog box configures the camera for the 
acquisition and it presents itself in different ways according to the type of camera in use. See 
the topic "The sharpVISION 1300-DE Camera Control" for the sharpVISION camera or the 
topic "The Roper Scientific ES1.0/ES4.0 Camera Control" for the Mega-plus cameras. 

 Toggle Direct Draw 
To refresh the live video at its maximum rates the Direct Draw Video mode needs to be 
enabled. The limitation under this mode is that not all the zoomed states (those that are 
fractional) are supported. Operation of the sharpVISION camera currently does not support the 
Direct Draw option. 

 Toggle Histogram Window 
This button opens the Image Acquisition Histogram window. 

 Camera Model 
This control shows the current camera Model. 

 Camera Selection 
The active camera can be selected through this combo box. When two cameras are supported 
the active camera can be: Camera A, Camera B or A&B. 
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33..44  CCaammeerraa  PPIIVV  TToooollbbaarr  

The camera PIV Toolbar appears on the left side of the Live Acquisition windows each time a 
new session is started. 

 Mode Buttons 
The camera windows can be set in two different modes, as separated windows or as a single 
stereo window. The modes can be changed operating on the Mode buttons on the "PIV 
Toolbar". 

 Display Check Boxes 
The check boxes enable/disable the display of the raw images and the graphic overlay that 
comprises the mesh, the vectors (when calculated) and the origin of the vectors. 

 Active Mesh Buttons 
More than one active mesh may be associated with an image file. These buttons allow the user 
to cycle through the meshes and associate the corresponding PIV parameters with them. 

 Image Controls 
These controls are used to setup the acquired image frames. The combo boxes control the 
indices of the image pairs. The spin buttons control the stride of the images for PIV processing. 
If the stride is one every image is correlated (paired) with the previous and the successive 
image. Stride two is the most common and assumes that the even numbered images are 
paired with the odd numbered ones. A stride three correlates subsequent images as it does 
stride two but it skips the record every three images. Stride four skips the record by four images 
and so forth… 
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 Calibration Controls 
These controls are used to save an image acquired from a camera as a calibration image. This 
image is automatically saved on a corresponding calibration directory. This calibration directory 
is a child directory of the Session directory that is automatically opened when the camera 
view(s) are enabled. The user is prompted for the directory name. This directory becomes the 
parent for the storage of images from subsequent acquisitions. For more information on the 
directory structure see the topic “Image Acquisition Overview”. Alternatively the user may 
browse for calibration images from stored image files (See the topic "Save/Import Calibration 
Images"). Once a calibration image is stored the user is further prompted to perform the 
calibration. For information regarding the calibration procedure refer to the “Calibration 
Procedure”. If a calibration is “active” the calibration file name and the ON button are displayed. 
Conversely when the calibration is not present the OFF button is displayed. 

 Mask Controls 
These controls are used to manage the mask operations on the acquired images. Masking is 
operated using a binary image overlapped to the acquired images. The ON/OFF button 
displays and hides images, respectively activating and deactivating the mask feature. The 
mask image can be saved/exported or imported and can be also edited (See the topic 
"Creating Mask Images"). The build mask Image option allows the user to create a mask 
image from a sequence of acquired images (See the topic "Mask"). 

 Process Button 
This button starts/stops the correlation process. It's active only when at least one image pair in 
double exposure mode has been acquired. Otherwise the button is grayed. 

 On-line Button 
This button enables/disables the on-line images processing. It is active only when the camera 
mode is in double exposure. To start the on-line processing the user must press this button and 
then press the Play button in the camera Toolbar. 

 Settings Button 
This button enables the Settings dialog box for the PIV processing. 
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33..55  PPIIVV  PPrroocceessssiinngg  TToooollbbaarr  

 

 

 

Image Selection Controls 
The controls are used to load images from sessions. Under the image selection additional 
information is displayed to include the family file name, the number of frames contained in the 
file and the stride of the images for PIV processing. If the stride is one every image is correlated 
(paired) with the previous and the successive image. Stride two is the most common and 
assumes that the even numbered images are paired with the odd numbered ones. With a 
value of stride three, the program correlates subsequent images as it does stride two but it 
skips the record every three images. Stride four skips the record by four images and so forth… 

Process Button 
This button starts/stops the correlation process. It's active only when image pairs are loaded. 

Settings Button 
This button enables the Settings dialog box for the PIV processing. 

Display Check Boxes 
The check boxes enable/disable the display of the raw images and the graphic overlay that 
comprises the mesh, the vectors (when calculated) and the vectors' origin. 

Mesh Buttons 
More than one active mesh may be associated with an image file. These buttons allow the user 
to cycle through the meshes and associate the corresponding PIV parameters with them. 

Calibration Controls 
These controls indicate the name of the calibration file and whether it is active. 

Mask Controls 
These controls are used to manage the mask operations on the acquired images. Masking is 
operated using a binary image overlapped to the acquired images. The ON/OFF button 
displays and hides images, respectively activating and deactivating the mask feature. The 
mask image can be saved/exported or imported and can be also edited (See the topic "Mask"). 
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33..66  TThhee  pprrooVVIISSIIOONN  MMeennuu  

3.6.1 The File Menu 

At start up the File menu contains the following commands: 

New Image 
The new image menu item allows the user to create a new “blank” image with a prescribed size 
and a constant color background. 

New Movie 
A dialog box allows the user to create a movie file by adding different image files to a list. The 
user can browse the computer resources and add files from different directories. 

New PIV Batch 
A dialog box allows the user to select image pairs and sequences and process them in Batch 
mode. 

Open Image File 
Stored image files are opened via the open command. An important feature of proVISION is 
that all common color and monochrome image file formats are supported. For a detailed list, 
please see the “Image Formats” topic in the Appendix. 

Open PIV Window (Analysis) 
This option opens a new PIV processing window, used to obtain the velocity information from 
archived image data. 

Open PIV Window (Live Video) 
This option opens the image acquisition windows (one if the is 2D, two if it’s 3D). 

If at least one image file is open, the File menu contains also: 

Close 
This option closes the current image window. 

Save 
Images may be manipulated by a variety of operators: Morphological, LUT, etc. Upon 
modification, images may be re-saved. This is done by the Save command. The filename as 
well as the file type for storage are selected by the user’s choices. Uncompressed and 
compressed file formats are supported. 

Save As 
This command allows saving the selected image with settings different from the default. 

Print 
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The active document can be printed. The Print Common dialog box allows selecting the printer 
as well as other print parameters. 

Print Preview 
This command shows the Print preview window. 

Print Setup 
This command opens the Print Setup common dialog box. The user can configure the installed 
printers settings. 

 

3.6.2 The Edit Menu 

Undo 
The Undo selection allows the user to undo previous operations performed on the images. 

Copy 
The Copy command allows copying images to the clipboard buffer.  

Paste 
Copy command allows pasting images from the clipboard buffer.  

 

3.6.3 The View Menu 

The selections under this menu allow the user to select the size of the image with the option to 
show the image 1:1, or zoom it to various states to include sizes that either Fit the window or 
snap the image. 

The user may also enable/disable the display of the Toolbar and the Status bar. The menu also 
features an elementary Graphics Toolbar provides the user with some capability to add 
geometries/and or text to the images. If a PIV Analysis or Live Video Window is open the user 
may enable/disable the Piv Tool Bar. 

A Ruler can also be enabled for display. The ruler units can be set to inches or centimeters. 

During image acquisition the video window is enabled. Image acquisition currently supports the 
Mega-plus ES1.0 and ES4.0 cameras and the IDT sharpVISION 1300-DE camera. To refresh 
the live video at its maximum rates the Direct Draw Video mode needs to be enabled. The 
limitation under this mode is that not all the zoomed states (those that are fractional) are 
supported.  

NOTE: The sharpVISION camera currently does not support the Direct Draw option. 

 

3.6.4 The Transform Menu 

Some geometrical image transformations are available through the transform menu. 



 

18 

Flip Horizontal/Vertical 
This command flips the image onto its horizontal or vertical axis. With horizontal flip the left 
column of pixels becomes the right column. With vertical flip the bottom row becomes the first 
row. 

Rotate 
The image can be rotated by 90, 180, 270 degrees clockwise and by a configurable angle. 
When a configurable angle is used the new, rotated image, is obtained by an interpolating 
scheme. 

Shear 
This option moves the corners of the image in the fashion of a parallelogram. The shear may 
be horizontal (the image rows are displaced horizontally with respect to each other) or vertical 
(the image columns are displaced vertically with respect to each other). The user may specify 
the angle of slant and the type of shear. 

Resize 
The original size of the image may be reduced or enlarged. It is important to note that an 
interpolating algorithm is used to perform such transformations. 

 

3.6.5 The Image Menu 

This menu provides a means to apply mathematical and logical operators to selected images. 
The supported operators are: 

Sharpening Filters 
The supported sharpening filters are: Gradient, Laplace, Sobel, Prewitt, Shift-Different and Line 
Segment. 

Smoothing Filters 
The supported smoothing filters are: Average, Median and De-speckle. 

User Defined Filters 
The user can configure different filters by clicking the “Define User Filter…” menu item. A dialog 
box appears. The user can set the filter coefficients, load and save the filters in external 
configuration files (with FLT extension). The current filter can be applied to the image by 
selecting the “User Filter” menu item. 

Other Effects 
Other operators are: Posterize, Mosaic, Add Noise, Emboss and Underlay Image. 

Average Images 
Images from different files can be averaged into one. When this menu item is selected a dialog 
box allows the user to specify the images to average. A new image is created. 

Compute Image 
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Two different images can be logically computed. The supported operators are: AND, OR, XOR, 
ADD, SUBSTRACT, MULTIPLY, DIVIDE, AVERAGE, MINIMUM and MAXIMUM. 

 

3.6.6 The Color Menu 

It provides a mean for image contrast and intensity changes, i.e., LUT transformations. 

Color Map 
A color mapped lookup table can be applied to gray scaled images. Two pre-defined color 
schemes are available (Small Rainbow and Two Colors). 

Brightness and Contrast 
The intensity (Brightness) and the contrast of the current image can be changed. Valid values 
are between 100 and –100.  Negative values decrease (or darken) the brightness and the 
contrast of the bitmap image. 

Hue and Saturation 
The hue and the saturation of the colors of the current image can be changed. Valid values are 
between 100 and –100.  The filter can be applied only to color image files. 

Color Inversion 
The filter inverts the colors in the current image, making it like a photographic negative. 

Histogram Equalize 
The filter linearizes the number of pixels per gray level in the current image. This can be used 
to bring out the detail in dark areas of an image. 

Histogram Contrast 
The filter increases or decreases the contrast of the current image, using a histogram to 
determine the median brightness. This function finds the median brightness of the image; then 
brightens the pixels with values above the median and darkens the pixels with values below 
the median. 

Stretch Intensity 
The filter increases the contrast in the current image by centering, maximizing, and 
proportioning the range of intensity values. 

Gamma Correct 
The filter adjusts the intensity of colors in the current image by changing the gamma constant 
that is used to map the intensity values. Intensity values ideally follow a logarithmic 
progression, because the eye perceives changes in intensity as being equal when the ratio of 
change is equal. 

Intensity Detect 
The function filters the current image to detect colors in a specified intensity range. Two 
thresholds, low and high, define the range. Valid values are between 0 and 255. 
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Conversion 
The current image can be converted into a different color format: 1 bit, 8 bit, 8 bit Gray Scale, 
and 8 bit Pseudo-color and True Color. 

Separation 
The filter separates the current image by color plane to produce one grayscale image per 
plane. The user can specify any of several color-space models: 

• RGB (three planes). 

• CMYK (four planes). 

• HSV (three planes). 

• HLS (three planes). 

• CMY (three planes). 

Combine 
The filter creates a color bitmap by merging grayscale bitmaps that were created as color 
separations. 

 

3.6.7 The Tools Menu 

Laser Control 
This option toggles the Timing/Laser Settings Dialog box, used to synchronize and operate the 
laser illumination source(s). 

Options 
The general options, configured during the installation can be updated to reflect changes on 
the hardware configuration and/or the path of the database used to store images and data files. 
The options item the dialog box that allows the user to configure the database path as well as 
configure the software to correctly operate with different camera and motorized focus options. 

Movie Editor 
The editing of a movie file consists of adding or deleting “pages” to the movie file. The currently 
supported movie file is the Multi-Page TIFF format (*.MPT). In this format a sequence of 
images can be stored as “pages” under a single filename.  
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44  IImmaaggee  AAccqquuiissiittiioonn  

44..11  OOvveerrvviieeww  

The PIV 2000 system is configured during the installation to support the sharpVISION 
cameras that use the IEEE-1394 serial interface or the conventional PCI frame grabber 
interfaces required by the Roper Scientific cameras. The camera models from Roper 
Scientific that are supported are the model ES1.0 8bit, ES1.0 TH, ES1.0 SC and the ES4.0-
8bit. Upon request the custom interfaces can also support the ES1.0-10 bit and the ES4.0-
12bit. Depending on the hardware configuration the system is automatically configured to 
operate either in a single or dual camera configuration. 

In the application the images, the system configuration files and the results are automatically 
organized in a specific directory structure. The directory structure is first created when the 
image acquisition is initiated. This happens at the first use of the proVISION Acquisition Tool. 

4.1.1 Session 

 

Initially the user is prompted to supply the name for a SESSION. There are three options to 
open and configure a Session: 

Create a New Session 
The user inserts the User name, the session name and a comment (brief description of the 
session) and presses enter. A new top (parent) directory is created. This parent (SESSION) 
directory is contained in the IDT\ProVISION\Db folder created during the installation of the 
program, unless the user specifies an alternative location. 
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Open Setup Session (Test Only) 
The setup Session is a pre-set directory where all the acquired data and settings can be 
overwritten. As the name indicates this option is available for use during the set-up phase of 
the experiment. 

Open Existing Session 
To open an existing Session the user MUST be sure that the settings have not changed. 
This is used to append data to the directory structure that has been previously created. 

4.1.2 Calibration 

Once the SESSION directory is created the camera windows are enabled and the user is 
reminded that a calibration image needs to be acquired. This calibration image is used to 
convert the image pixels into actual object length units (mm). 

A dialog box reminds the user that the calibration image can be acquired and saved or 
imported from an existing record in the proVISION database. 

 

The calibration is used to convert the units of pixels in the image to real object units (mm). It is 
highly recommended that a calibration image be acquired prior to further acquiring image data. 
When the user proceeds with image acquisition without prior acquisition of calibration image 
file, a default directory named _No_Calib is automatically created. This directory is used to 
store directories containing images from subsequently acquired sequences. 

If a calibration image is acquired and saved the program prompts the user for a name. 

The calibration image is automatically saved and its name is used to create a new directory 
under the SESSION in which the calibration image will be stored. At this point the user also has 
the opportunity to generate a calibration file from the stored image. See the topic "Calibrate" in 
the How To… section for a detailed description of the calibration procedure. 

4.1.3 Acquisition 

Subsequent image acquisitions are stored in directories under the parent calibration directory 
following a numbering system as: Acquis000, Acqui001, etc.  

4.1.4 Analysis 

Each Acquisition directory can have a set of subdirectory in which the results of the PIV 
processing are stored. The subdirectories follow the same numbering system as the 
acquisitions: Analysis000, Analysis001, and Analysis003 … 
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Each Analysis directory contains the PIV settings and the plot files generated after the 
processing. See the topic "PIV Settings Dialog Box" for a detailed description of the PIV 
Settings. 

 

44..22  SSiinnggllee  oorr  DDuuaall  CCaammeerraa  SSyysstteemmss  

The system may be configured to operate one or two cameras simultaneously. Once the user 
has supplied all the information in then Open Session Dialog Box the program automatically 
detects how many cameras are configured on the system and activates them. A PIV Camera 
window is opened for each camera and the Horizontal Camera Toolbar is displayed. Each 
Camera Window has a vertical Camera PIV Toolbar on his left side. 

The Horizontal Camera Toolbar controls the cameras settings and allows the user to start/stop 
the camera, acquire and so on. The vertical Camera PIV Toolbar controls the PIV Settings and 
allows the user to correlate the data acquired from the cameras. 

If two cameras are active, the camera windows can be set in two different modes, as separated 
windows or as a single stereo window. The modes can be changed operating on the Mode 
buttons on the "PIV Toolbar". 

IT IS IMPORTANT TO REALIZE, HOWEVER THAT BOTH CAMERAS WILL BE CONTROLLED 
BY A UNIQUE SET OF CONTROLS, AND WILL BE CONFIGURED IDENTICALLY. 

 

4.2.1 Single Camera 
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If only one camera is active, the program opens a single camera window. The "3D" button on 
the "PIV Camera Toolbar" is disabled and the user can operate only in 2D mode. 

4.2.2 Dual Camera (Two Separated Windows) 

 

An example of the two camera windows opened simultaneously is shown in the figure above. 
The camera control tool bar reflects the presence of two cameras A and B. The active camera 
can be selected in the camera selection combo in the toolbar. 

Using the camera Tool Bar the user may select to operate both or either of the cameras 
independently. 



 

25 

4.2.3 Dual Camera (Single Stereo Window) 

 

If the system is used in the stereo mode it is more convenient to tile the two stereo-pair images 
from each camera into a single window. This is accomplished by pushing the 3D button on the 
camera window toolbar. The resulting window is shown as an example in the figure above. The 
commands and controls remain the same for both cameras and configurations are identical. 

The main advantage of the single tile image in the 3D mode is that saving and restoring the 
images is done as if there was a single image. The image mode 2D/3D is coded onto the 
image file itself such that the images are saved/opened as 2D/3D automatically. 
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44..33  CCaammeerraa  SSeettuupp  

All the camera controls to include the exposure, recording and acquisition modes are 
conveniently placed on the camera toolbar. The toolbar also includes informational displays, 
such as the camera type and the current camera selection. The camera properties dialog box 
configures the camera for the acquisition. This dialog is accessed via the button with the 

camera icon . The first Tab of this dialog box presents itself different ways according to the 
type of camera in use. 

4.3.1 The sharpVISION Camera Control 

 

The parameters are described below: 

• Mode: the default state of the camera at start-up is in the Continuous mode. This mode is 
used to arrange the experimental set-up. In this mode the camera does not require a 
trigger input signal. The other camera modes (Triggered and Double exposure) require an 
external trigger input. The "PIV-2000 Timing Controller" provides the trigger input. When 
the laser is off, the camera works in continuous mode only; when it's ON, the user can 
select the triggered or double exposure mode from the combo box. 

• Frequency: this grayed edit box displays the actual frame rate of the camera. The value is 
calculated taking into account other parameters such as the binning, the exposure time, 
the pixel format, etc. 

• Binning:  the user can select the binning mode from 1x1 to 4x4. In this fashion pixels may 
be grouped to form a larger pixel, which results in added SNR and sensitivity. The 
parameter cannot be changed when the camera is playing. 

• Contrast and Brightness: the contrast and brightness of the image produced by the 
camera may be adjusted. The values range from –100 to 100. 

• Exposure: the camera exposure may be adjusted. The value is in milliseconds. 
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• Acquisition Time Out: the acquisition and snap time out may be configured. The value is 
in seconds. 

• Pixel Format: the camera digitizer is a 12-bit digitizer. The output can be 8-bit (gray8) or 
10-bit (gray16). Cameras are also provided with the with 12 bit output. The parameter 
cannot be changed when the camera is playing. 

• Readout: this parameter controls the speed at which the image data is read from the CCD. 
The supported values are: 20 MHz, 10 MHz, 5 MHz and 2MHz. 

• Camera Cooler: The camera cooler feature may be activated. The parameter enables and 
disables the thermoelectric-cooler. 

• Use shutter: this parameter must be set to Yes if the camera has a shutter connected to 
the timing box. When this option is active the application automatically adjusts the timing 
signals for the laser and camera triggering. For further information, see the Laser/Camera 
Trigger Control topic.  

 

4.3.2 The Roper Scientific ES1.0/ES4.0 Camera Control 

The supported cameras are the Roper Scientific ES 1.0, the ES 1.0 SC and the ES 4.0. 

 

The first property page is the camera control. The parameters are described below: 

• Mode: the default state of the camera at start-up is in the Continuous mode. This mode is 
used to arrange the experimental set-up. In this mode the camera does not require a 
trigger input signal. The other camera modes (Triggered and Double exposure) require an 
external trigger input. The "PIV-2000 Timing Controller" provides the trigger input. When 
the laser is off, the camera works in continuous mode only, when it's ON, the user can 
select the triggered or double exposure mode from the combo box. 

• Binning (only the ES 4.0 model supports this parameter): The value can be selected 
from 1X1 to 2X2. The ES 1.0 model works only on 1X1 binning. 

• Rate: this read-only edit box shows the current acquisition rate. 
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• Exposure: the camera exposure may be adjusted. The value is in milliseconds. 

• Time Out: the acquisition and snap time out may be configured. The value is in seconds. 

• Transfer Delay and Pulse Width: these edit box are read-only. The transfer pulse delay 
and its duration are optimised and adjusted automatically by the software in accordance to 
the timing interface. 

• Strobe Polarity: the cameras also offer a pulse output for synchronization with other 
events, such as a strobe. The polarity of this pulse is configurable (Negative, Positive). 

• Trigger polarity: the trigger polarity can be controlled. It may be Positive or Negative. 

• Gain:  The camera GAIN is from 1 to 4 for the ES 1.0 and 1 to 16 for the ES 4.0. 

• Use Shutter: this parameter must be set to Yes if the camera has a shutter connected to 
the timing box. When this option is active the application automatically adjusts the timing 
signals for the laser and camera triggering. For further information, see the Laser/Camera 
Trigger Control topic. 

• Look-Up Table: a Look Up Table can operate the images. Three pre-defined LUT Types 
are supported: Linear, Exponential and Gate. For each of these types, the user can 
configure two parameters (Gain and Offset for Linear and exponential, Low Pass and Hi 
Pass for the gate). 
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4.3.3 The Camera Focus Control Page 

 

 

 

The camera motor configuration is displayed the first time that the page with camera focus 
control is accessed. In case the optional motorization is installed and the motor controls are 
switched ‘ON’, the motors are found and the appropriate initialization routines are invoked. At 
start-up the user has the option to select the COM port value.  

Once the motors have appropriately initialized the Camera Focus Control Dialog page is 
displayed. 

 

Each camera possesses two motors to control both the position of the lens focal plane 
(Translation) and the Rotation angle to achieve the Scheimpflug angle. To minimize the risk of 
malfunction, ONLY one motor may be accessed at the time. To focus use the Translation first 
to obtain sharp images in the center of the image, then use the Rotation control to sharpen the 
edges. Repeat this procedure until the sharpest focus is obtained. 
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• Reset/Home Buttons: these controls allow restoring the Home position in case the motors 
have been switched off and the absolute position has been lost. 

• Motor Selection: this combo-box allows selecting the current motor (Camera A 
translation, Camera A rotation, Camera B translation and Camera B rotation). 

• Arrows Buttons: press these buttons to move the selected motor. Press the same button 
to stop the motor. 

• Set Position Slider: this control allows defining the position where the motor must move. 
Just drag and drop the slider to the desired position and the motor will move. The indicator 
on the right shows the position in mm or degrees. 

• Actual Position Slider: the control shows the current position of the active motor. The 
user cannot change the position of the slider. 

• Speed Slider: this control sets the speed of the selected motor. 

• Rescan Button: press this button to scan the com port and refresh the status of the 
motors. 

To ensure that the live video rate is sufficient to assure quick feedback, enable the Direct Draw 
Video feature while focusing the camera. This option is available only on Roper Scientific cameras. 

4.3.4  
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4.3.5 The Image Layout Page 

This page allows the user to configure the camera for ROI acquire, thus reserving the image 
capture for the regions of interest only, as well as to perform simple geometric transformations 
during the acquisition. 

 

• Configuration: the acquired images may be combined to produce a single image or 
displayed in overlay. The overlay feature is especially useful for camera alignment with 
targets. 

• Flip and Rotate: each camera image can be flipped (vertically and/or horizontally) and 
rotated (0, 90, 180, 270 degrees). 

• Region Of Interest (ROI): these controls allow setting the cameras areas of interest. The 
image capture is reserved for these areas only. 

4.3.6  
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4.3.7 The Image Histogram Page 

The Image Histogram page allows the user to display the Image Histogram window each time 
the cameras windows are updated. The Histogram window is invoked when the user clicks the 

Histogram button  on the Camera toolbar. 

 

For each velocity component some parameter can be set: 

• Auto Bin Size: when this check box is checked the Histogram is displayed using the 
calculated minimum and maximum value of the image pixels. The range between the min 
and the max is divided into the number of bins configured in the Number of Bins control. 
When it's unchecked the user may edit the minimum and the maximum values. 

• Number of Bins: the number of steps between the minimum and the maximum. 

• Minimum Value: if the Auto Bin size is unchecked the user can edit the minimum value. 

• Maximum Value: if the Auto Bin size is unchecked the user can edit the maximum value. 
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44..44  AAccqquuiissiittiioonn  RReeccoorrddiinngg  SSeettuupp  

This dialog box sets-up the recording parameters and can be invoked by pressing the Record 

Setup button  on the "Camera Toolbar". 

 

 

When images are recorded they are streamed to HOST RAM. The maximum number of 
images that can be streamed at the video rate to HOST memory depends on the maximum 
system capacity and the number that the user allows.  When a longer record is required, the 
file storage feature needs to be enabled. In this case, the system acquires to RAM followed to 
a write to disk until the desired record length is achieved. 

Record Parameters 

• Samples: the number of samples can be set according to the acquisition mode. In 
continuous and triggered mode it corresponds to the number of acquired frames, while in 
double exposure it corresponds to the image pairs. The "Images/Camera" control shows 
the actual number of acquired frames. 

• Images/Samples: this control shows the number of images per sample. In continuous and 
in triggered mode this value is 1, while in double exposure mode is 2. 

• Cameras: the number of cameras currently active. 

• Images/Camera: this control shows the number of images per camera. In continuous and 
in triggered mode it corresponds to the number of samples, while in double exposure it's 2 
times the configured samples. 
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• Memory Limit: this parameter limits the amount of RAM memory that can be used to 
acquire the images. If the "System" value is set, the application reserves all the system 
memory minus 60 MB reserved for other applications. 

• Allocated Memory: this control displays the amount of memory allocated for the 
acquisition. The value is (number of samples)*(Images per sample)*(number of 
cameras)*(size of one image). 

Acquisition Start-up 

• Event: this combo box allows the user to control which event is going to start each 
acquisition. If it is set to "Keyboard/Mouse" the user starts the acquisition by pressing the 
record button on the camera toolbar and then the play button. If it's set to "External" the 
acquisition is started by the "Trigger In" signal generated by the timing box. When the user 
presses the "Record" button on the camera toolbar,  the program is set in "Wait" mode: 
when the "Trigger In" signal is on, a timer is started and after a period defined in the 
"Delay" parameter edit box (see below), the acquisition is started . 

• Delay: if the Event parameter is set to "External", a delay can be defined. 

Acquisition Storage 

• Use File Storage: if this check box is unchecked, the Acquisition Storage controls are 
disabled. Otherwise, the images are stored in the hard disk after the acquisition. 

• Save On-line images: if this check box is checked the acquisitions made during on-line 
processing are stored in the hard disk.  

• Acquisition Name: this parameter cannot be set. The read-only edit box displays the 
name of the directory where the frames will be stored. The directory is a sub-directory of 
the current Session and calibration directories. 

• Comment: this line is associated to the acquired sequence. 

• Save As Type: this combo box controls the file format. See the Topic "Image Formats" in 
the Appendix for a detailed description of the supported formats. 
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44..55  LLaasseerr//CCaammeerraa  TTrriiggggeerr  CCoonnttrrooll  

The timing interface provides the necessary trigger signals to operate a solid state laser such 
as an Nd:YAG or a Diode Pumped Solid State laser. It produces TTL type output signals that 
drive the lamp and the Q-Switch triggers. The unit also outputs two TTL signals for triggering 
cameras (A and B) as well as TRG OUT that can be used to synchronize other hardware 
components. The Timing Control Unit also provides outputs to trigger the cameras, and 
incorporate a synchronization output from the cameras each time a frame is generated. The 
unit can be driven by an external TTL high-true clock signal at the TRIG IN lead. This input can 
also be used to drive the unit by an external random event. 

The hardware is configured to supply the trigger signals as listed on the table below. 

Laser/Camera Timing Unit Signal Leads 
Signal Description Level 
TRG IN Ext Trigger signal input TTL HIGH-TRUE 

TRG OUT Trigger output TTL HIGH-TRUE 

CAMERA A Camera A Trigger TTL HIGH-TRUE 

CAMERA B Camera B Trigger TTL HIGH-TRUE 

FLASH LAMP A Flash Lamp A Trigger TTL HIGH-TRUE 

FLASH LAMP B Flash Lamp A Trigger TTL HIGH-TRUE 

Q-SWITCH A Q-Switch A Trigger TTL HIGH-TRUE 

Q-SWITCH B Q-Switch B Trigger TTL HIGH-TRUE 

 

If the camera is supplied with a mechanical shutter and the "Use Shutter" option is active on 
the Camera Setup dialog box, the timing signals for the laser and camera triggering are 
adjusted. This option can be activated in the configurations listed in the table below. 

Shutter Option Availability 
Mode Nd:Yag Laser DPSS Laser 
INTERNAL YES NO 

EXTERNAL YES (if external frequency is less than 200 Hz) NO 

SYNCH NO NO 

 

The laser/camera trigger control is accessed via the button with the light bulb icon  on the 
main toolbar. The Laser Type and the maximum operating frequency may be set in the 
General Options Dialog Box. Two laser types are available: 

• Nd:Yag Lasers. 

• Diode Pumped Solid State Lasers. 
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4.5.1 ND:YAG Laser 

The trigger signals are generated and output by the Timing Control Unit. The controller 
supports three modes of operation of the laser/camera triggering. The modes are INTERNAL, 
EXTERNAL and SYNCHRONOUS. The interface provides a toggle switch to set the operation 
mode. In the default state the switch is set to INTERNAL. 

The user may change the operation mode only if the ON/OFF button of the Laser/Timing 
Dialog is in the OFF position so that the laser is turned OFF. The laser cannot be turned into 
ON if one of the following conditions is TRUE: 

1. In internal mode, the "Laser Frequency" is zero. 

2. In external mode, the external frequency is big, so that the resultant laser frequency is 
bigger than the "Maximum Laser Frequency" parameter set in the General Options Dialog 
Box.  

The trigger signals actually used by the Laser/Camera system are listed on the table below. 

Nd:Yag Laser Timing Signals 
Signal Description Timing Level 
TRG IN Ext Trigger signal input Reference T0 TTL HIGH-TRUE 

TRG OUT Trigger output T0 TTL HIGH-TRUE 

CAMERA A Camera A Trigger T0 TTL HIGH-TRUE 

CAMERA B Camera B Trigger T0 TTL HIGH-TRUE 

FLASH LAMP A Flash Lamp A Trigger T0 TTL HIGH-TRUE 

FLASH LAMP B Flash Lamp A Trigger T0 TTL HIGH-TRUE 

Q-SWITCH A Q-Switch A Trigger T0 + (60 – 600 μsec) configurable TTL HIGH-TRUE 

Q-SWITCH B Q-Switch B Trigger T0 + (60 – 600 μsec) configurable TTL HIGH-TRUE 
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4.5.1.1 Internal Mode 

 

This is the default state at the program start-up. Under this mode of operation an internal clock 
generates all of the required timing signals. The laser and camera triggering signals are derived 
from this clock. The software Laser Trigger Control sets the desired rate for the laser operation, 
the separation between laser pulses and the required delay between the flash lamp and the 
Pock-cells (Q-switch) triggers. The figure below shows the signals. 

 

The rate may be continuously set from 0 to the maximum frequency (configured in the general 
options dialog box), while the pulse separation and the Q-switch trigger delay may be adjusted 
from less than 1 microsecond to 10 milliseconds with increments of 0.05 microseconds 
(50 nanosecond).  The camera is triggered synchronously and phased locked with the laser. 
However an additional control allows the user to trigger the camera at a sub-harmonic 
frequency. This is achieved by means of a frequency divider (See Figure below). 
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4.5.1.2 External Mode 

 

The external mode allows for the system to be synchronized by an external clock.  The figure 
shows the software interface. In this mode a TTL compatible drive signal is required at TRG 
IN. The timing control unit has the capability to accurately measure and display the frequency 
of the external clock signal. Because the input clock frequency can be much higher than that 
supported by the laser/camera system, frequency dividers are available for both the laser and 
camera operation. The laser frequency is obtained dividing the external frequency by the 
"Laser Freq Divider" and the result is divided by the "Camera Freq Divider" to obtain the 
Camera frequency. Just like in the internal mode in the EXT mode, the laser and the camera 
frequency may not be the same. 

The figure below shows the signals. In the example, the external frequency is divided by two to 
obtain the Laser frequency (Trigger Out, Flash Lamp and Q-switch); then the Laser Frequency 
is divided by two to obtain the Camera Acquisition Frequency. 
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The phase of this input signal can be conditioned by a variable delay. The delay is adjusted as 
fractions (degrees) of the period of the input clock. This feature is very useful to phase lock 
external, periodic events (See figure below). 
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4.5.1.3 Sync Mode 

 

This mode is used for synchronization with external random events.  The figure shows the 
software interface. In this mode a TTL compatible drive signal is required at TRG IN. The 
system will not respond to input triggers faster than the maximum laser operating frequency as 
set by the laser frequency dial (accessed by the INT Mode). 

In this mode the laser and the camera are operated in sync with an external trigger. 
Synchronization of the laser with random external events can be made in spite of the 
requirement for the laser to be operated at a constant rate. The principle of operation is as 
follows. The external trigger initiates a gate with an adjustable length (Trigger Out). The length 
of the gate is adjusted as a multiple of the period of the laser rate. This is set by the 'Delay 
Cycles' parameter on the software control. During the high state of the gate the flash lamp of 
the laser operates at the prescribed rate, i.e. for the number of prescribed cycles. The camera 
and Q-Switch triggers follow the last pulse of this gated signal. When the delays cycle is set to 
one the delay between the trigger pulse input signal and the laser light pulse is equal to 100 
μsec plus the Q-switch delay setting. The initial, fixed delay of 100 μsec is required to setup 
the triggering circuit. If the number of cycles is larger than one then the delay is increased by 
the (number of delay cycles – 1) times the period corresponding to the set laser frequency. The 
laser frequency is set on the INTERNAL MODE panel. The figure below shows the signals 
in a configuration of 3 delays cycles. 
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A delay can be added to the gate. The value is in ms (see figure below). The value is added to 
the delay cycles to obtain the delay from the "trigger in" signal. 
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4.5.2 Diode Pumped Solid State Laser 

In applications where limited pulse separation and energy are required, such as low speed-
flows or micro-PIV an alternate low cost laser source may be recommended. IDT offers 
extremely compact Diode Pumped Solid State (DPSS) lasers. 

The trigger signals are generated and output by the Timing Control Unit. The controller 
supports three modes of operation of the laser/camera triggering. The modes are INTERNAL, 
EXTERNAL and SYNCHRONOUS. The interface provides a toggle switch to set the operation 
mode. In the default state the switch is set to INTERNAL. 

The user may change the operation mode only if the ON/OFF button of the Laser/Timing 
Dialog is in the OFF position so that the laser is turned OFF. The laser cannot be turned into 
ON if one of the following condition is TRUE: 

3. In internal mode, the "Laser Frequency" is zero. 

4. In external mode, the external frequency is big, so that the resultant laser frequency is 
bigger than the "Maximum Laser Frequency" parameter set in the General Options Dialog 
Box.  

The trigger signals actually used by the Laser/Camera system are listed on the table below. 

DPSS Laser Timing Signals 
Signal Description Timing Level 
TRG IN Ext Trigger signal input Reference T0 TTL HIGH-TRUE 

TRG OUT Trigger output T0 TTL HIGH-TRUE 

CAMERA A Camera A Trigger T0 TTL HIGH-TRUE 

CAMERA B Camera B Trigger T0 TTL HIGH-TRUE 

Q-SWITCH A Laser Trigger T0  TTL HIGH-TRUE 
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4.5.2.1 Internal Mode 

 

This is the default state at the program start-up. Under this mode of operation an internal clock 
generates all of the required timing signals. The laser and camera triggering signals are derived 
from this clock. The software Laser Trigger Control sets the desired rate for the laser operation, 
the separation between laser pulses and the required duty cycle of the wave. The rate may be 
continuously set from 0 to the maximum frequency value (set in the general options dialog 
box), while the minimum pulse separation must be 100 microseconds. 

The internal clock trigger generates a pulse train with an adjustable frequency and a duty cycle 
of 50% (Trigger Out) . During each high state of the signal the Q-switch signal of the laser 
operates as a pulse train. The period and the duty cycle of this train are respectively set by the 
"Pulse separation" and the "Pulse Duty Cycle" parameters. The camera is triggered during the 
last two cycles of the Q-switch gated signal. The figure below shows the signals. 
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4.5.2.2 External Mode 

 

The external mode allows for the system to be synchronized by an external clock. In this mode 
a TTL compatible drive signal is required at TRG IN. The timing control unit has the 
capability to accurately measure and display the frequency of the external clock signal. 
Because the input clock frequency can be much higher than that supported by the 
laser/camera system, a frequency divider is available for both the laser and camera operation. 
The laser/camera frequency is obtained dividing the external frequency by the "Laser Freq 
Divider". 

The figure below shows the signals. In the example, the external frequency is divided by two to 
obtain the Laser and camera frequencies. 

 

The phase of this input signal can be conditioned by a variable delay. The delay is adjusted as 
fractions (degrees) of the period of the input clock. This feature is very useful to phase lock 
external, periodic events (See figure below). 
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4.5.2.3 Synch Mode 

 

This mode is used for synchronization with external random events. In this mode a TTL 
compatible drive signal is required at TRG IN. The system will not respond to input triggers 
faster than the maximum laser operating frequency as set by the laser frequency dial 
(accessed by the INT Mode). 

In this mode the laser and the camera are operated in sync with an external trigger. The 
external event is used as a trigger to initiate a gate with an adjustable length. The length of the 
gate is adjusted as a multiple of the "Pulse Separation" parameter. During the high level of the 
gate the Q-switch of the laser operates as a pulse train. The period and the duty cycle of this 
signal are respectively set by the "Pulse separation" and the "Pulse Duty Cycle" parameters. 
The camera is triggered during the last two cycles of the Q-switch gated signal. 

The figure below shows the signals obtained setting the "Delay Pulses" parameter to zero. The 
gate length is two times the Pulse Separation, so the Q-switch signal generates only two 
pulses and the camera is triggered at the same time.  

 

Even if the Delay Cycles value is zero and the "TRG Delay" knob is set to the minimum, the 
TRG Delay [ms] control displays a value that is not zero. This is because the q-switch signal is 
a low to high signal, so it starts low and after a time which depends on the duty cycle goes to 
high. The time is: 

Minimum Delay = (1 – Pulse_Duty_Cycle)*Pulse_Separation 

The figure below shows a sample obtained setting the "Delay Pulses" to four and adding a 
small delay in the "TRG Delay [ms]" control knob. 
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The value displayed in the TRG Delay control is the sum of all the delays: 

Delay [ms] = (Delay_cycles)*Pulse_Sep + ( 1 – Duty Cycle)*Pulse_Sep + Added Delay 
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44..66  SSaavvee//IImmppoorrtt  CCaalliibbrraattiioonn  IImmaaggee  

One or more images acquired from the cameras can be saved as a calibration image by 

pressing the  "Save Calibration Image" button  in the Camera PIV Toolbar. The images 
are automatically saved on a corresponding calibration directory. This calibration directory is a 
child directory of the Session directory that is automatically open when the camera view(s) are 
enabled. This directory becomes the parent for the storage of images from subsequent 
acquisitions. When the user presses the button, a dialog box appears: 

 

The user is prompted for the directory name, the calibration type and the number of calibration 
images to be saved. There are two different calibration types (standard or distorted). 

Alternatively, the user may browse for calibration images from stored image files. Once a 
calibration image is stored the user can perform the calibration. For information regarding the 
calibration procedure refer to the “How to… Calibrate” topic. If a calibration is “active” the 
calibration file name and the ON button are displayed. Conversely, when the calibration is not 
present the OFF button is displayed. 

4.6.1 Standard Calibration 

If the user selects the standard calibration only one image is saved, both in 2D and 3D mode. 
After the image is saved a message box warns the user. 

 

For further information about the Standard Calibration, see the Topic "Calibration Procedure". 
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4.6.2 Distorted Calibration 

If the calibration is distorted the number of images to save differs. In 2D mode the image is only 
one, but in 3D mode the program needs at least 5 images. When the user presses the Next 
button, a second dialog box appears: 

 

The user is asked to move the calibration target in the Z direction and input the displacement of 
each movement. The displacement of the first image is 0. Other displacements can be both 
positive and negative. After the user has moved the target and edited the Z position 
(displacement), the Next Button can be pressed. The program acquires the mew image, stores 
it in the calibration directory, increases the progress indicator, and prompts for the next value 
and so forth. 

For further information about the Standard Calibration, see the Topic "Calibration Procedure". 
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44..77  CCrreeaattiinngg  MMaasskk  IImmaaggeess  

A mask binary image can be created from an acquisition sequence by clicking the  "Build 
Mask Image" button on the Camera PIV Toolbar. A dialog box appears: 

 

The preview pane shows the image currently acquired. The image is binarized using a 
threshold value displayed in the Threshold edit box. It can also be reversed, swapping the 
black pixels with the black ones. 

The mask image can be also created from the average of a sequence. The user can set the 
number of samples to acquire and start the acquisition by pressing the Build Image button. A 
progress bar and a counter display the acquisition progress. 

For a detailed description of the Mask procedure, see the topic "Mask". 
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55  PPIIVV  PPrroocceessssiinngg  TToooollss  
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55..11  OOvveerrvviieeww  

Once the images have been acquired from the cameras and stored into the proVISION 
Database, they may be re-opened and processed. 

Two ways of open and process the images are available. 

Open PIV Analysis Window: a sequence of images may be opened by selecting the Open 
PIV Window (Analysis)… item in the File menu or by pressing the "New PIV Analysis 
Window" on the main Toolbar. 

PIV Batch: series of single image pairs or sequences can be processed in a Batch mode by 
selecting the New PIV Batch item in the File menu or by pressing the indicated button on the 
PIV Toolbar. 



 

54 

55..22  OOppeenniinngg  aa  PPIIVV  pprroocceessssiinngg  WWiinnddooww    

To enable a PIV processing window Select Open PIV Window (Analysis) from the File menu 
item or press the corresponding button on the menu bar. The following dialog box becomes 
active: 

 

The tree view on the left displays the image files from the available Sessions. The commonly 
supported image formats are listed in the "Image Formats" in the Appendix. 

Each Session organizes the image files in acquisition folders. Acquisition folder 000 is reserved 
for On-line Processing operations, whereas all the other folders contain the images that form a 
sequence. The maximum sequence is 1000 frames long. Image acquisition folders are 
subfolders of their corresponding calibration folder. In case a calibration is not available the 
images are stored under a _No_Calib folder.  However the user has the opportunity to 
associate a calibration image after the acquisition has been completed. This option is available 
every time an un-calibrated image is opened. A dialog box prompts the user for the calibration 
file. 

Image files are automatically loaded as a sequence with the “delayed” image automatically 
selected as the next numbered file in the sequence. At this time all of the images with the same 
family name (in the sequence) are automatically loaded. Additionally, a mesh is displayed as a 
graphic overlay.  

The name convention for the stored images is to use letters to denominate the image base 
name and a series of numbers from 000-999 to denominate the position of the image in a 
sequence.  As an example if a sequence of 10 images were stored as individual TIFF files 
under the name IMGA, they would be named as IMGA000 through IMGA009. In contrast the 
MPT file format achieves the storage of multiple TIFF files under a single name, in this case 
IMGA. 3D images are denominated IMG3D. 

The reference (first exposure image) and the delayed (second exposure image) are displayed 
superposed to each other on the PIV Tool Window. Using the pull down image box of the 
reference one may select which image of the sequence to display. The delayed image is 
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defaulted as the next numbered image in the sequence, unless the user by means of the pull 
down selection box selects another image.  

Once the image files have been loaded the proVISION application tries to locate and load an 
existing PIV processing settings files, that contains all of the parameters required for the 
reduction of the image files. 

The PIV Processing Window contains all of the necessary controls for the processing and 
presentation of the results. 

The Image Selection group of buttons indicates whether the loaded images are single images 
(2D) or a stereo view (3D), how many frames the sequence contains and allows the user to 
select the image pair and the stride. 

The Display control allows the user to enable/disable the display of the image(s) as well as the 
mesh and the vector overlay. 

The Mesh control allows the user to toggle between meshes when more than one mesh is 
created.  

There are two action buttons: 

• The Process button initiates the processing of the images to obtain the velocity at the 
intersecting points of the mesh. 

• The Settings button enables a multi-page dialog box with the Processing parameters. 

The Calibration group indicates information about the calibration settings. The upper static 
control shows if the calibration is loaded and, if yes, indicates the name of the calibration file. 
The button below displays if the calibration is ON or OFF. 

The Mask controls are used to manage the mask operations on the acquired images. Masking 
is operated using a binary image overlapped to the acquired images. The ON/OFF button 
displays and hides that images respectively activating and deactivating the mask feature. The 
mask image can be saved/exported or imported and can be also edited (See the topic "Mask"). 
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55..33  BBaattcchh  MMooddee  PPrroocceessssiinngg  

Series of single image pairs or sequences can be processed in a Batch mode. The Batch 
loader is invoked by selecting the New PIV Batch item in the File menu or by pressing the 
indicated button on the PIV Toolbar. 

 

Files associated with different calibrations and PIV configurations may be loaded for 
subsequent processing. The calibration and configuration files are loaded automatically when 
an image file is selected. The file selection is carried out through the tree view on the left. 

For each image family name, regardless whether they are a single image pair or a sequence, 
or the type of file format, one can associate a configuration file that specifies to the code the 
processing parameters. Additionally, while processing 3D images different perspective 
calibration files corresponding to their images can also be prescribed. 

The batch loader controls are described below: 

• Images Tree View: it displays the current proVISION database contents. The user can select 
the images from this tree view. 

• PIV Settings: if a set of loaded images has more than one set of PIV settings (Analysis 
subdirectories) the user can select one of them by pressing the Browse button. The user 
can select a configuration from all the sub-folders of the same calibration folder. 

• Mask Image: if a set of images has one or more mask images the user can select one of 
them via the "Mask Image" combo-box. 

• Image Stride: the spin buttons control the stride of the images for PIV processing. If the 
stride is 1 every image is correlated (paired) with the previous and the successive image. 
Stride two is the most common and assumes that the even numbered images are paired 
with the odd numbered ones. A stride three correlates subsequent images as it does stride 
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two but it skips the record every three images. Stride four skips the record by four images 
and so forth… 

• Add and Remove Buttons: once the user has selected an image family with mask and piv 
settings, he can add it to the batch list by pressing the Add button or delete it from the list by 
pressing the remove button. 

• Files List: all the images selected are displayed in the list with all their parameters. 

• Start Button: once the images are loaded, pressing the Start Button can start the correlation 
process. A new PIV window is created and the images are loaded in sequence. The Batch 
configuration dialog box disappear and while Batch Status Dialog box appears. 

 

 

 

The Batch Status dialog box displays the names of the session, the calibration and the images 
currently processed, the total number of processed pairs and the elapsed time. The user can 
abort the process by pressing the Abort Button. 



 

58 

55..44  CCaalliibbrraattiioonn  PPrroocceedduurree  

The calibration procedure is invoked in the Calibration page of the PIV Settings Window. The 
calibrate button must be pressed. 

There are two different calibration types that can be selected on the "Calibration model" 
combo-box. 

5.4.1 Standard Calibration 

The procedure activates a dialog Box and a rectangle (two if the image is 3D). Any rectangle 
has four handles that have to be moved and positioned on equivalent points of each image. 
Optimal accuracy is achieved when the handles are positioned close to the borders of the 
image. The color of the rectangles may be configured. 

 

The next step in the calibration is to specify the pixel size of the sensor, the physical size of the 
square or rectangle determined by the handles (mm), the focal length of the lenses (mm), and 
the type of perspective involved. If the image is 2D the diagonal parameter can be set instead 
of the X dimension value. 

If the image is 2D the Use Perspective flag can be checked and unchecked. If it's unchecked 
the calibration procedure just computes a magnification factor that converts the pixels into mm. 

In 3D mode the perspective type allows to specify the position of the cameras relative to the 
laser sheet. This parameter affects the correspondence between the points of the two views: 

 Same Side: the cameras "see" the same side of the laser sheet. 

 Opposite Side: the cameras "see" the laser sheet from two different sides. 

NOTE: With this calibration, the accuracy is achieved only if the cameras are perfectly aligned in the 
horizontal plane. 
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5.4.2 Distorted Calibration 

The procedure activates a dialog box and a rectangular grid (two if the image is 3D). The 
number of points can be configured and each point of the grid has handles that can be moved 
and positioned on equivalent points of each image. More accuracy is achieved increasing the 
number of points of the grid and positioning the handles close to the borders of the calibration 
image. A large number of points allow adapting the grid to a very distorted calibration target 
image. 

 

The grid mode indicates how the points of the mesh can be handled: 

• Zoom: only the four corners of the mesh have the handles. The mesh can only be moved 
or zoomed. 

• Free: each point of the mesh has handles and can be dragged independently. 

• Constrained: only the four corners of the mesh have handles. The mesh can be moved 
and distorted. 

The grid color may also be configured. 

The next step in the calibration is to specify the physical size of the square or rectangle 
determined by the handles (mm) and the type of perspective (3D only). If the image is 3D the Z 
position of each calibration image can be set (see the topic "Distorted Calibration"). 

Also the calibration target thickness may be set. 

In 3D mode the perspective type allows to specify the position of the cameras relative to the 
laser sheet. This parameter affects the correspondence between the points of the two views: 

 Same Side: the cameras "see" the same side of the laser sheet. 

 Opposite Side: the cameras "see" the laser sheet from two different sides. 
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55..55  MMaasskk  

Masking is operated using a binary image overlapped to the acquired images. The ON/OFF 
button displays and hides that image, respectively activating and deactivating the mask feature. 
The mask image pixels can be only white or black: White pixels are transparent, while black 
ones hide the corresponding points of the image pair. When the correlation is performed the 
points of the mesh that are over a mask point are not calculated. 

The user can create the mask image in two different ways: 

• Build Mask Image Option: a sequence of images acquired by the camera(s) can be 
binaries and used as mask image (See the topic "Mask"). 

• Edit Mask Image Option: when the mask image is on, the "Edit mask" button on the PIV 
toolbar is enabled. When this button is pressed a Mask Pad appears. 

5.5.1 Edit Mask Pad 

           

 Clear Mask 
By pressing this button the whole mask image is cleared (white). 

 Mask/Unmask 
This is a check button. When it is unchecked (the figure is a capital M on black background) the 
mask objects (lines, rectangles and ellipses) can be added to the mask image. When it's 
checked (the figure is a capital U on white background) the mask objects can be subtracted 
from the mask image. 

 Brush 
The brush object allows the user to paint areas of the mask image. Press the brush button and 
select the line width in pixels. Then hold down the left mouse button and drag the pointer. 

 Line 
A multiple line object can be created and moved on the mask image. Press the line button and 
select the line width in pixels. Then click the left mouse button over the points where the 
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multiple line has to be drawn.  Drag the line handles to position the points. Then right click and 
select "Apply Mask". 

 Rectangle 
A rectangle can be created, dragged and resized on the mask image. Press the rectangle 
button and click on the point where the rectangle has to be drawn. Then drag it or resize it 
dragging the handles. Then right click and select "Apply Mask". 

 Ellipse 
An ellipse can be created, dragged and resized on the mask image. Press the ellipse button 
and click on the point where the ellipse has to be drawn. Then drag it or resize it dragging the 
handles. Then right click and select "Apply Mask". 

 Polygon 
A polygon can be created, dragged and resized on the mask image. Press the polygon button 
and select the number of points. Then click on the point where the polygon has to be drawn. 
Select the move mode (zoom, free, constrained) to move, resize, stretch or zoom the object. 
Then right click and select "Apply Mask". 

5.5.2 Mask Popup Menu 

When the mask image is edited, a pop-up menu appears any time the user right clicks on the 
paint area. The menu items are: 

• Apply mask: when a drawing object is created, the user must select this item to add the 
object to the mask image. 

• Delete object: a selected object can be deleted. 

• Undo latest operation: the undo feature. 

 

5.5.3 Mask Import/Export 

Each mask image can be imported from an external file or exported to a new file. By pressing 

the Open/Import button  the Import mask dialog box appears. 
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The tree view on the left shows all the mask images available in the provision database. The 
user can select one of the images and press OK. The image is automatically loaded and 
displayed on the screen. 

The Export/Save mask Image Button  allows the user to save the current mask image on 
the Acquisition directory. 

 

The list view on the left side of the dialog, lists the names of the mask files available on the 
directory (existing mask files) and the name of a new file that can be created. The user can 
overwrite existing files or create a new one. The Delete File button allows deleting useless 
mask images. 
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55..66  PPIIVV  SSeettttiinnggss  DDiiaalloogg  BBooxx  

The PIV settings dialog box is multi-page and contains all of the parameters required for the 
processing of the image pairs. It can be invoked by pressing the "Settings..." button in the PIV 
Toolbar. 

 

The PIV Settings Title bar displays the camera selection (A, B, 3D) that was active when the 
images have been acquired, and the Analysis index that corresponds to the active PIV 
settings. 

If the software does not support the calibration feature the Calibration Tab is not displayed. 
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5.6.1 Configurations Page 

All the parameters of the processing algorithm as well as the mesh can be stored for later 
retrieval on a configuration file. The configuration file has the file extension *.piv. The storage 
and retrieval of configuration files is done using the buttons on the Configuration Page: 

 

 

• Load PIV Settings: the settings files are loaded from a results folder and this folder becomes 
the current one. 

• Create New Results Folder: a new results folder is created and the current settings are 
copied to the new folder. 

• Import PIV Settings: the user selects the settings from the database and these settings are 
copied in the current folder. 

• Save PIV Settings: the current PIV settings are saved in the current folder. 
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5.6.2 Calibration Page 

The calibration page displays the parameters of the current calibration file, if the calibration is 
loaded. Otherwise, the calibration is disabled.  

 

• Calibration Model: the combo box displays the current calibration type (Standard or distorted). 
If the calibration has not been done yet, the user can select one of the two types, otherwise the 
type is locked. 

• Calibrate: this button is enabled only if the calibration image is available. The button starts the 
calibration procedure described in the "Calibration Procedure" topic. 

• Image: by pressing this button, the calibration image associated to the images is loaded and 
displayed (or unloaded). If the images are stored in a subdirectory of the _No_Calib directory 
and no calibration images are associated to the images, a message box warns the user. 

• Save: this button allows saving the calibration settings to a file. 

• Advanced: by pressing this button, a dialog box, which displays the values of the parameters 
of the calibration, appears. 

• Parameters: this section displays the most significant parameters of the calibration. X Dim and 
Y Dim are the dimensions of the calibration grid. For further information, see the topic 
"Calibration Procedure". 
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5.6.3 Correlation Page 

In this page the relevant parameters that configure the correlation algorithm are set.  ALL OF 
THE PARAMETERS ARE SET IN PIXELS. 

 

• View A / View B: if the image is 3D, each view can have its own correlation parameters; 
otherwise only one view parameters can be edited. 

• Interrogation Size and Mode: the code may be configured to run a ‘Standard’ correlation. The 
user has the choice on the size of the correlation window. In the Standard mode the correlation 
is done by correlating corresponding and equal sized windows in the reference and delayed 
images. In the Adaptive mode the correlation is calculated on a subset of the grid points using 
an interrogation size of at least 24 pixels. The results are validated and used as ‘predicted’ 
vector values. Then the correlation is calculated and the predicted values are used as a local 
offset for the delayed image. 

• Range Filter: the default is set to Auto mode. In this mode the code finds automatically the 
displacement range throughout the region of the image overlay by the computation mesh. For 
optimal results when operating the correlation in the “standard” mode the interrogation size 
should be at least three times the maximum pixel displacement. The Range Filter indicates the 
maximum displacement. When the “Auto” option is selected the Auto Range procedure 
calculates the maximum displacement and automatically adjusts the correlation size to three 
times this value. 

• Delay Image Offset: optimally, one should have the velocity range symmetrically arranged 
around zero. This condition may be artificially met by the use of the offset parameter of the 
delayed image. Setting this parameter to a value different from zero forces the delayed image 
to be displaced (and shown) with a constant pixel displacement with respect to the reference 
image. If the ‘Add Offsets’ option is checked the offsets are added to the result vectors. 

• Error Check: the default state of the software enables the verification of the computed vectors 
using a multi layer check algorithm. There is a user set tolerance level of permitted error that 
may be varied from 1 .0 (less rigorous) to 0.1 (more rigorous). The default, which is quite 
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appropriate in most cases, is set to 1.0. The algorithm is based on a continuity check by 
comparing with the displacement values of the nearest neighbors in the selected mesh. 

During the computation of the displacement and validation procedure a qualifier flag that 
indicates the nature of the measurement affects each data point.  The flag codes are: 

(0) ‘UN-VALIDATED’ Vector: this value indicates a raw vector without being tested by the 
validation algorithm. 

(1) ‘BAD’ Vector: it is an intermediate code that indicates that the vector needs further 
computations to be transformed into one of the following values. 

(2) ‘INTERPOLATED’ Vector: this value indicates that the vector is the result of at least 
square interpolation of nearest neighbors. 

(3) ‘RECOMPUTED’ Vector: this value indicates that the vector is obtained by tightening the 
search for the peak and/or by increasing the interrogation region. 

(4) ‘VALID’ Vector: this vector indicates valid data. 

(5) ‘NO DATA’ Mesh Point: a ‘no-data’ point condition occurs when there are no particle 
images detected on the interrogation region. In this case the code can treat these points as 
disabled (by leaving the ‘compute dropout’ box unchecked) or ultimately interpolating them 
using the least squares algorithm. 

(6) ‘DISABLED’ Mesh Point: this flag indicates a mesh point where the vector cannot be 
calculated.  

• Contrast: the Contrast parameter defines whether a mesh point can be considered as a 
dropout. The value may vary from a minimum value of 0.05 to a maximum of 1.0. For each 
point of the mesh the code checks if the maximum pixel value in the interrogation area is bigger 
than the contrast value. If it’s smaller and the “compute dropouts” option is checked, the vector 
value is obtained by interpolation, otherwise the point is disabled. 

• Vector Derivatives: The computation of the vector derivatives includes the derivatives of the x- 
and y-components of the displacement with respect to x and y. The size of derivative kernel 
can be adjusted. The minimum value of x and y neighbor is 1. 
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5.6.4 Histogram Page 

The Histogram page allows the user to display the velocity Histogram window each time the 
correlation process is invoked. 

 

For each velocity component some parameter can be set: 

• Auto Bin Size: when this check box is checked the Histogram is displayed using the 
calculated minimum and maximum value of the component. The range between the min and 
the max is divided into the number of bins configured in the Bins control. When it's unchecked 
the user can edit the minimum and the maximum values. 

• Number of Bins: the number of steps between the minimum and the maximum. 

• Minimum Value: if the Auto Bin size is unchecked the user can edit the minimum value. 

• Maximum Value: if the Auto Bin size is unchecked the user can edit the maximum value. 

The figure shows an example of Histogram. The results for each component are presented 
each on its separate page. If the image is 2D the W component is not available. 
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5.6.5 Output Page 

The results of the computation can be stored in a Tecplot ready file for viewing or manipulation 
by the user.  

 

There are several options for the presentation of the results that are user configurable: 

• Save Vectors To File: the first option refers to the saving of the vector file. If the check box is 
checked, the user can select the format of the file (BINARY or ASCII). The advantage of the 
BINARY format is the savings in space whereas the ASCII format allows for the opening of the 
file under other WINDOWS applications such as EXCEL. 

• Enable 2D Vector map: this option is available only for 3D images. When the check box is 
checked, the results of 3D images can be saved in two files, one for each view. 

• Configurable Output: the controls in this section allow configuring which variables have to be 
recorded in the plot files. The supported variables are different for 2D and 3D images. 

 2D Images: any plot files contains X, Y, U and V. The variables Ux, Uy, Vx, Vy, Vector Flag 
and Correlation Size can be configured. 

 3D images: any plot file contains X, Y, Z, U, V and W. The variables Ux, Uy, Vx, Vy, Wx, 
Wy, Vector Flag and Correlation Size can be configured. 

The variables can also be combined in two functions. 

• Launch Tecplot: if this check box is checked Tecplot is launched each time a correlation 
process is invoked. The results are displayed with the Layout file selected in the Layout File (for 
vectors) and Average Lay File (for Averages) edit boxes. 

• Layout File and Average Lay File: the edit boxes show the layout file used for the display of 
the vectors when Tecplot is launched. If no values are specified the Default2D.lay or 
Default3D.lay files are used. 
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5.6.6 Mesh Page 

The mesh page controls the size and the position of the active mesh. If more than one mesh 
has been created, the user can select the active mesh operating on the mesh buttons in the piv 
toolbar. 

 

• Minimum and maximum Coordinates: the mesh boundaries may be interactively set 
using the mouse cursor by dragging it to position and using the white handles to resized it. 
The edit boxes may be used to achieve precision in the positioning. 

• Mesh Nodes: the number of nodes on the X and Y axis can be changed by clicking the 
spin buttons on the right side of the Nodes edit boxes. 

• Mesh Auto Spacing: if this button is checked the program provides automatically the 
optimal number of mesh points. 

• Stretch: the mesh can be stretched both in X and Y directions. 

• Rotation: the mesh can be rotated clockwise or counter-clockwise by clicking the spin 
buttons on the right side of the Rotation edit box. Valid rotation angles are from –90 to 90 
degrees. Each step is 0.1 degrees and the rotation axis is located on the upper left corner 
of the grid. 

• Mode: the combo-box allows selecting how the points of the mesh may be handled. 

 Zoom: the mesh handles are on the four corners. When one of them is dragged the 
mesh is zoomed. 

 Free: the handles appear on each point of the mesh boundaries. When one of these 
points is dragged, only the points of the relative row/column are affected. 

 Constrained: the mesh handles are on the four corners. When one of them is 
dragged, the mesh is distorted. 

• Restore rectangle: when this button is pressed, a rectangular mesh is restored. 

• Mesh Name: the edit box indicates the file name of the current mesh. 

• Import/Export: Mesh files can be imported and exported. 
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• Mesh Color: the color of the mesh can be selected among 16 different colors. 

 

 

 

5.6.7 Image Filters Page 

Prior to performing the correlation the code allows for pre-filtering of the image data with 
conventional high and low pass filtering algorithms. The Image Filters page allows the user  to 
configure the filtering operation such that more than one filter may be applied to the data in 
sequence. 
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5.6.8 Vectors Page 

The vector page has the attributes of the vector field in the overlay 

 

• Length: when the Auto check box is checked the program automatically calculates a 
scaling factor to display the vectors. Otherwise the user can input the value in the Vector 
scale edit box. In the same group two information boxes display the vector units (pixels, m, 
pixels/ms, m/s) and the Time between laser pulses, if available). 

• Arrow Head: the vector's arrowhead can be configured. 

• Anchor Position: the user can select which part of the vector has to be located in the 
point where the correlation is calculated. 

• Colors: calculated vectors and interpolated ones (bad Vectors) can be displayed in 
different colors. 

• Interpolation Cut-off: this parameter allows configuring the maximum number of 
interpolated vectors an image can contain. If after a calculation the number of interpolated 
vectors is bigger than the parameter, the results are not displayed and saved. This may be 
useful in a sequence to exclude "bad" images. 

• Average Cut-off: this parameter is used in the vectors average computations. If in a mesh 
point the number of valid vectors is less than the parameter, the point is disabled in the 
average plt file. 

• Origin: the vectors origin coordinates can be edited in the edit boxes. The origin can be 
changed also dragging the cross in the screen. The color of the displayed cross may also 
be changed. 
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5.6.9 Sequence Page 

Once an image sequence is loaded it is possible to process it with a single command entry and 
generate averages (based on whether the appropriate box is checked on the Output page). 
This command entry is made from the Sequence page. 

 

• Starting Image: the user has the ability to specify the initial image from which the 
computation starts. 

• Maximum Pairs: this parameter sets how many image pairs will be processed. 

• Image Stride: the spin buttons control the stride of the images for PIV processing. If the 
stride is 1 every image is correlated (paired) with the previous and the successive image. 
Stride two is the most common and assumes that the even numbered images are paired 
with the odd numbered ones. A stride three correlates subsequent images as it does stride 
two but it skips the record every three images. Stride four skips the record by four images 
and so forth… 

• Start: the correlation process starts when this button is pressed. During the process, the 
status is displayed in the Status Control group. 
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66  HHooww  TToo……  

66..11  EEddiitt  tthhee  ggeenneerraall  ooppttiioonnss  ppaarraammeetteerrss  

The general options, configured during the installation can be updated to reflect changes on 
the hardware configuration and/or the path of the database used to store images and data files. 

The options button  enables the Options Dialog box.  

 

6.1.1 General 

 

 

This dialog box allows the user to configure the database path as well as configure the 
software to correctly operate with different camera and motorized focus options. 

• Browse database Path: the current proVISION database path is displayed in the read-
only edit box. To set a database located in a different path, press the browse button and 
browse the computer. A valid database directory must contain the proVISION.mdb file. 

• Default Camera Model: the combo displays the current camera model. 

• Motors Type: the combo displays the motor type selected during the setup. 
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• Motors COM Port: the combo displays the current COM port selection. This value must 
match the COM port connected to the motor controller. 

• Enable camera diagnostic trace: if this option is checked, camera operations are logged 
in a text file for diagnostic purposes. For the sharpVISION cameras, the files sharp_01.txt 
and sharp_02.txt are generated. 

• Show Main menu dialog at startup: if this option is checked the main menu dialog box is 
shown when provision is started. 
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6.1.2 Laser 

 

This dialog box allows configuring the laser settings. 

• Laser Type: the combo displays the two laser options: Nd:Yag and DPSS. 

• Maximum Laser Frequency: the user may set the maximum operating frequency of the 
laser. The application checks the laser frequency and does not allow the user to set values 
that are bigger than the configured parameter. 

• Minimum Laser Pulse Separation: the user may set the minimum amount of time 
between two laser pulses. The application checks the value and does not allow the user to 
set values that are smaller than the configured parameter. 

NOTE: Once the Options have been changed it is necessary to exit and re-enter the program to 
make them effective. 
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66..22  AAccqquuiirree  ddaattaa  

Accessing the camera window(s) and setting up the Session: The camera window(s) are 

enabled via the button  in the main tool bar. This also initiates the set up of a session. The 
session is initiated to guarantee that the images and associated files are saved in a directory 
structure. 

Single and dual camera operation: The program is set up to automatically configure for 
operation with a single or two cameras. However the cameras have to be of the same type and 
model. A complete description of the camera and the parameters involved is given in the 
“Image Acquisition” section. 

Stereo mode of operation: Systems configured with two cameras can be operated in “stereo” 
mode. In this mode the camera images are tiled into a single image. This image is tagged with 
a “3D” tag indicating that it contains two stereo-pairs. The main advantage of this setting is that 
a single image filename and file system is required to describe a stereo image pair. The file 
opening and saving of these images is done in the usual manner similar to that of a single 
image. 

The calibration image: The top directory of an image acquisition is the Session directory. 
Under this directory there are several directories with the names of the calibration images 
provided by the user. The images in these directories are used to convert the pixel units of the 
images in actual object units (mm). Each acquisition that is performed using the same 
“geometry” is saved as a child directory under the calibration directory. These directories are 
automatically named in sequence as Acqui001, Acqui002, etc. Refer to the “Calibration” topic 
to learn more about the calibration procedure. 

Acquiring image sequences: Image sequences with up to 1000 individual frames can be 
acquired, in either the 2D or the 3D file system. Depending on the program settings and the 
available computer system RAM Image sequences are acquired in two fashions: 

• Live memory (RAM): If sufficient memory is available to store the entire sequence, as 
indicated by the resource meter on the Acquisition/Recording set up dialog box, images 
are acquired to RAM at the rate indicated on the camera set up box. This is done by 
depressing the record button, followed by the play button on the camera control tool bar. 
The acquired images can be played back using the buttons on the same tool bar. This is 
the preferred mode if an acquisition were the real time between image samples need to be 
specified and known. After the acquisition the images can be saved to disk using the Save 
item of the File menu. Alternatively, images can also be automatically saved using the 
check box of the Acquisition/Recording set up dialog. 

• To disk: When the memory resources are exceeded by the number of required images to 
be captured, the system automatically configures a directory for image storage. The 
images are then acquired at the rate displayed on the camera set up box in chunks that fit 
the available memory until the total number of images in the sequence is reached. 
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66..33  SSaavvee  iimmaaggee  ddaattaa  

Subsequent to an acquisition the image sequence may be saved to a file using the Save as… 
item under the File menu. When image sequences are acquired but NOT saved a warning 
message is displayed. 

 

This message warns the user that a sequence of unsaved images exists in memory and that 
the recording will overwrite it. The warning also includes an auto-disabling feature. 

The user has the choice of saving the images in a variety of supported image formats with or 
without compression. See “Supported Image Formats” in the Appendix. 
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66..44  CCaalliibbrraattee  iimmaaggeess  

The images calibration is divided into two steps: 

• Save or import the calibration image (topic "Save/Import calibration Image"). 

• Perform the calibration procedure (topic "Calibration Procedure"). 
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66..55  OOnn--lliinnee  PPrroocceessssiinngg  

 

Setup: the images may be processed to obtain the velocity data immediately after an 
acquisition. This is the so-called “On-line” mode. To set up the system for “On-line” processing 
the user must have the cameras in the “Double exposure” mode. It is important to note that this 
mode can only enabled when the laser/camera trigger is ON. The following button 

 on the PIV side tool bar on the camera window is used to enable “On-line” 
processing. 

Optimization of PIV parameters: While the images are acquired and processed the user may 
change the following parameters: Camera focus, camera LUT, gain,  laser/camera triggering 
times. These parameters are interactively changed to achieve optimal configuration of the 
system for subsequent recordings. 
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66..66  PPrroocceessss  ffiillee  iimmaaggeess  

 

File images can be processed using the PIV analysis window . This button allows the user 
selection of file images stored in the various child directories of a Session directory.  

 

By default the program automatically associates to the file images the corresponding 
calibration image if there is one saved. If a calibration image is not available the user is 
prompted to import one from the database. 

 

In case that there is no suitable image that can be used for calibration, all subsequent 
operations will use as unit of length the pixel. 

The processing variables, such as the interrogation region, mesh and algorithm details are all 
accessed from a single Settings button on the PIV tool bar. Detailed explanations on the 
meaning of the parameters in this dialog box are given in the “PIV Processing Tools” section. 
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66..77  CCoonnffiigguurree  tthhee  rreessuullttss  

The user may configure the way the velocity vectors are displayed in overlay and how the 
Histogram is arranged in classes. These configurations are part of the Settings dialog box.  

 

 

 

66..88  CCoonnffiigguurree  TTeeccpplloott  

In addition to displaying the vectors, as an image overlay, the user may enable the Tecplot 
display. The proVISION application program launches Tecplot as if it were a window of the 
main application. The vectors and any other pertinent information, such as the velocity 
derivatives or gradients are displayed using a default layout file. However, the user may select 
from existing layout files as to the style to display the information. 

The user may also change the current layout for reflect a new way to display the data. What is 
very important to note is that the program creates a new default layout file for the presentation 
of the data that is called IMGA.lay in the 2-D files and IMG3D.lay for 3-D files. If the user makes 
changes to these files it is imperative that the file be re-saved within Tecplot, otherwise the 
changes are lost.  
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77  PPIIVV  PPrroocceessssiinngg  EExxaammpplleess  

77..11  LLooww  SSppeeeedd  JJeett  FFllooww  ((22DD))  

7.1.1 Loading the Images 

Open a new PIV processing window by clicking the button on the main toolbar or by selecting 
from the menu the items Tools and PIV window (Analysis). Locate the path Low Speed 
Jet\_No_Calib\Acquis000, then select the file ImgA.tif and click OK. This file structure indicates 
that the images were acquired without a calibration, and that the file type is tiff. 

A warning message tells you that the image is not associated to a calibration and asks you to 
import it from existing records. Because the right calibration image does not exist, select No. 

An image pair is opened. The two images are displayed together. In this mode the particle 
image pairs are evident. 

7.1.2 Processing the Data 

By default the image has a computation mesh in overlay. You may accesses the PIV 
correlation parameters by clicking on the Settings button. On top of the configuration page the 
folder where the results are to be stored is shown (Analysis000). To display the remaining 
parameters for the correlation are viewed by selecting the appropriate pages. 

The computation is executed by pressing the Process button. 

The default interrogation window is 20 pixels and the processing mode is the standard mode. 
The Range filter, which is in Auto mode finds and indicates the range on motion in pixels. In 
this case: 1 > U > -5 (x-component) and 2 > V > 2 (y-component). This filter clips the search of 
the of the correlation peak to those areas, thus making the algorithm immune to possible noise 
sources outside the range. Additionally, the automatic error check is also enabled to remove 
and replace “bad” vectors. 

For this computation the vector derivatives are not enabled and therefore not evaluated. The 
user has the opportunity to check their computation “ON”, and to select the size of the 
differencing kernel. The default value the central difference is x=2 and y=2. Additionally, the 
user may enable the “interpolation” of regions of signal drop out, i.e. regions of the flow without 
any seeding. Such a flow is given in the following example. 

To conduct the correlation in a more efficient manner it is desirable to “centre” the filter range. 
This is done using the image OFFSET feature. In this case a negative offset in the x-direction 
of -3 is used to make the range symmetric.  

NOTE: In subsequent computations the Range Filter may be taken out of the Auto mode. In some 
instances it is desirable, however to set the filter manually to include a larger range. In the present 
example we would set the filter to: 5>U>-5 and 2>V>-2, such that one is assured that the search for 
the correct correlation peak is not clipped. 
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In this example note that: 

1. The Add Offsets box makes the vectors to be displayed as if the offset had not been 
removed. 

2. The Range Filter has been set and the Auto button has been disabled. 

3. The Error check is automatically enabled 

4. The computation of the derivatives has been enabled. 

5. The red arrows show the interpolated vectors. 

6. The program automatically launches Tecplot with the default layout configuration. 

As an exercise, the user may interactively optimize the Range Filter together with the Image 
Offset parameter. It is noteworthy that the interrogation size is about right according to the 
stated rule that the size needs to be about 4 times the maximum displacement. However good 
results (=absence of interpolations) are achieved with an interrogation size set at 16-20 pixels. 

The mesh selection parameters are provided on the mesh page of the Settings dialog box. 

Program Output includes the Tecplot window with the default layout as shown. Configuring a 
Tecplot layout file did the graphical presentation. The Output page allows the user to select the 
layout file to be loaded. In this case the layout file ImagA.lay resident on the corresponding 
results folder was configured to present the results as vectors superposed on contours of 
vorticity. 
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77..22  SSeeeeddeedd  JJeett  iissssuuiinngg  iinn  aa  nnoonn--sseeeeddeedd  
eennvviirroonnmmeenntt  ((22DD))  ((CCoouurrtteessyy  TTeecchhnniioonn,,  IIssrraaeell))  

7.2.1 Loading the image 

Open a new PIV processing window by clicking the button on the main toolbar or by selecting 
from the menu the items Tools and PIV window (Analysis). Locate the path Israel 
(2D)\_No_Calib\Acquis000, then select the file ImgA and click OK. This file structure indicates 
that the images were acquired without a calibration. 

7.2.2 Processing the Data 

The distinguishing feature in these images is the lack of seeding in the entrainment flow. In this 
example we will learn how to deal with this potential problem. 

We will illustrate the program features that correctly address this potential problem by placing a 
mesh at the edge (shear layer) of the jet. This kind of mesh is supplied with the PIV Settings 
configuration file in the Database file structure. 

It is noteworthy that the regions without seeding are automatically indicated as “drop-outs”. This 
is achieved during the computation by appropriately flagging the vector locations corresponding 
to those locations as no-data points. Furthermore, if the file log flag is enabled on the Settings 
output page the flag types are recorded as well in the results file structure. In this case it is 
possible to use the blanking features of Tecplot to prevent the display of such data points. This 
is illustrated below. 
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77..33  SSuuppeerrssoonniicc  JJeett  ––  33DD  ––  OOppppoossiittee  VViieeww  

7.3.1 Loading the Image 

Open a new PIV processing window by clicking the button on the main toolbar or by selecting 
from the menu the items Tools and PIV window (Analysis). Locate the path Jet 
(3D)\Opposite\Acquis000, then select the file Img3D.mpt and click OK. This file structure 
indicates that the images were acquired with a calibration, and that the file type is Multiple TIFF 
(MPT). 

The file open routine recognizes from the file tag the mode and adjusts automatically the type 
of display. The horizontal tool bar associated with the window shows the file type (3D), the 
name and whether a calibration image and file has been associated with the file. 

To process 3-D files requires a calibration file such that the 3-D reconstruction may be 
operated. The calibration file is generated via a calibration procedure on an image acquired at 
the beginning of an acquisition session. The calibration may be done just after the 
calibration image is acquired or later prior to processing the image files. Accessing the 
Calibration Page of the Settings dialog box carries out this operation. The calibration image is 
recovered by pressing the input image button. A message box lets the user know that pressing 
the input image button may close the calibration image. 

When the calibration image is displayed the calibrate button is enabled. Pressing it will start the 
calibration process. See the "Calibrate" topic in the "How To…" section for a detailed 
description of the calibration process. 

7.3.2 Processing the Data 

Once the calibration is done the image files can be processed to generate the velocity fields. 
The input image button is depressed and the calibration image is removed from the overlay, 
showing again the image data, with the computation mesh on both stereo-pair images. At this 
point the processing is carried out much in the same manner as the 2-D files. To note is the 
fact that in the correlation page there are values for the filter setting and image offsets that are 
specific to each view. As each view produces a 2-D field the results are combined and 
displayed using the Tecplot data presentation package. This display is only available when it is 
enabled from the Output page. The 3-D presentation can be done according to the user’s 
needs by selecting a *.lay file. The software is configured with a default presentation that may 
be used by the user to generate others. 
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88  AAppppeennddiixx  

88..11  NNII--IIMMAAQQ  BBuuffffeerrss  SSeettttiinnggss  

The IMAQ driver has a default of 50 buffers that can be used for image acquisition. This 
number has to be set according to the amount of memory (RAM) that the computer has 
available. To enter the number of buffers, run the "Measurement and Automation" Explorer 
from your desktop or ImaqConfig.exe program located in the following directory: [drive 
letter]:/Program Files/National Instruments/NI-IMAQ/bin if you have an older version of the 
drivers. The program interface is shown in the figure below. 

 

Under the Tools menu select Max number of buffers. The dialog box below appears. Enter the 
number that corresponds to the available RAM minus 60, e.g., if the computer is configured 
with 256 MB of RAM enter 196 etc… 
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88..22  IImmaaggee  FFoorrmmaattss  

The image formats supported by proVISION Explorer are the following: 

• TIFF files. 

• Windows™ Bitmap Files. 

• PCX Files. 

• Multi-page TIFF Files (MPT). 

• Multi-page PCX Files (DCX). 

• Multiple RAW Files (MRF). This is an IDT proprietary format. 


	1  Before you start
	1.1 Using This Manual

	2  System Overview
	2.1 Overview
	2.2 System requirements
	2.3  Software Installation

	3  The proVISION GUI
	3.1 Overview
	3.2  Main proVISION Toolbar
	3.3  Camera Toolbar
	3.4  Camera PIV Toolbar
	3.5  PIV Processing Toolbar
	3.6  The proVISION Menu

	4  Image Acquisition
	4.1 Overview
	4.2 Single or Dual Camera Systems
	4.3  Camera Setup
	4.4  Acquisition Recording Setup
	4.5  Laser/Camera Trigger Control
	4.6  Save/Import Calibration Image
	4.7  Creating Mask Images

	5  PIV Processing Tools
	5.1  Overview
	5.2  Opening a PIV processing Window 
	5.3  Batch Mode Processing
	5.4  Calibration Procedure
	5.5  Mask
	5.6  PIV Settings Dialog Box

	6  How To…
	6.1 Edit the general options parameters
	6.2  Acquire data
	6.3  Save image data
	6.4  Calibrate images
	6.5  On-line Processing
	6.6  Process file images
	6.7  Configure the results
	6.8 Configure Tecplot

	7  PIV Processing Examples
	7.1 Low Speed Jet Flow (2D)
	7.2  Seeded Jet issuing in a non-seeded environment (2D) (Courtesy Technion, Israel)
	7.3  Supersonic Jet – 3D – Opposite View

	8  Appendix
	8.1 NI-IMAQ Buffers Settings
	8.2 Image Formats


